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Introduction

PDFtoMusic is a groundbreaking and unique program that converts Adobe PDF music sheets into editable music scores.
From an Adobe PDF file created by any music notation program, PDFtoMusic can play the piece, sing the lyrics and export this piece to
miscellaneous file formats: MIDI, Myr, BMP, WAV, AIFF and MusicXML  for the Pro version.
What can I use it for?
How does PDFtoMusic work?
What are the differences between the "Pro" and "Standard" version?

What can I use it for?

Usages for PDFtoMusic are numerous. First, on the Internet, many dedicated sites provide large collections of free musical PDF files.
PDFtoMusic will let you play them, or convert them into a music file format that you'll be able to modify by using your usual music notation
software.
Thus, PDFtoMusic gives you access to a wide library of public domain score sheets that you can play or edit.

Also, there are many music notation programs, and only a few manage compatible exchange file formats. PDFtoMusic solves this issue. You
just have, from your program, to generate a PDF file (see next chapter), read it with PDFtoMusic and convert it into format that can be read by
another application, for instance, Myr or MIDI format (or MusicXML for the Pro version).

PDFtoMusic becomes then a bridge between your miscellaneous music programs.

For instance: your choir master only uses "Music Architect 2000", that can only save files in its own, proprietary format. You just have to ask
him for a PDF file for the score, and by using PDFtoMusic, you'll get a score that can be edited in Harmony Assistant.

If you own the Pro version of PDFtoMusic, you can also export into MusicXML exchange format, from Recordare.  The Music XML file format is
currently supported by a number of notation applications, including Finale and Sibelius.

How does PDFtoMusic work?

PDFtoMusic analyzes the content of Adobe PDF files. It collects all the graphical information that it can process: fonts, lines, miscellaneous
graphic objects. From these graphical items, PDFtoMusic will infer the music score to be played.

Note : some PDF files (albeit rare) embed only a single picture for the whole score, instead of  a collection of simple graphic objects. This kind
of PDF file has probably been generated from a scanned paper sheet. PDFtoMusic can't extract and process elementary graphical items in
such cases, and reports that such a document cannot be processed.

To convert a PDF file, select "File>Open" in PDFtoMusic and select a PDF file on your hard drive. PDFtoMusic will load it, and start
automatically to process and display it.
If PDFtoMusic makes a mistake while processing the document, you will be able to fix this mistake manually. It is described in the corrections
section of this manual.

PDFtoMusic can export the result automatically each time a PDF file is processed, and open this result in the program of your choice.

What are the differences between the "Pro" and "Standard" version?

The "Pro version" includes options and features that are not present in the "Standard" version:
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- Batch file export, to convert in only one operation all PDF files from a folder and its subfolders.
- "Expert" mode to manually override individual default processing settings in order to have more precise control.
- Export in MusicXML format in order to preserve the score sheet layout when importing into one of the numerous programs that support this
format.
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How do I generate a PDF file from any software?
PDFtoMusic is able to convert a PDF document with such a high level of accuracy because it analyses the actual font characters which are
embedded in the PDF document.  

When asking for generating a PDF document, you must ask for the character fonts to be embedded into the PDF document. Generally, it's
the default setting.

If PDFtoMusic detects a font that is not embedded in the document, an alert will be displayed:

meaning that the rendering could be different from expected.

Here is how to create a PDF file, depending on your system kind:

With Windows

  With Mac OS X

  With Mac OS 9

  With Linux

http://www.myriad-online.com/resources/docs/pdftomusic/english/pdfgenwindows.htm
http://www.myriad-online.com/resources/docs/pdftomusic/english/pdfgenmacosx.htm
http://www.myriad-online.com/resources/docs/pdftomusic/english/pdfgenmacos9.htm
http://www.myriad-online.com/resources/docs/pdftomusic/english/pdfgenlinux.htm
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With Windows

To create PDF files from any music software (or any other application) under Windows, you must install a small program beforehand.
This program can be either a freeware, like PDFCreator (recommended) or PrimoPDF (not tested yet), a shareware, like PDF995, or a
commercial software package like the tools of the Adobe suite.

All these programs behave like a new printer for your computer.
When "printing" a document to it, a file name is asked, and the printing result is actually saved in PDF format.

PDFCreator can be downloaded from here: http://www.pdfforge.org/products/pdfcreator/download (select preferably the "MSI" installer).

Once downloaded and installed, when printing from any program, in the printer selector that appears:

Select the "PDFCreator" printer then click "Print".
You'll then get a window for entering optional information about the PDF file to be created (Title, date, author...), then a file selector for
specifying the name and location of this file.

The PDF file that matches what you asked for being printed is then generated, and can be opened by PDFtoMusic.

You can then either send this file by e-mail to somebody else, or process it with PDFtoMusic to convert it into the file format you need.

 
`

http://www.pdfforge.org/products/pdfcreator/download
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With Mac OS X

With a Macintosh under Mac OS X, it's quite easy to generate a PDF file from any program, by using the print dialog box. Once the file is
loaded into the software, select "File>Print". The printer selector opens, and you can select here the page range to be printed.  
In the bottom part of this box, you'll see a "PDF" or "Save as PDF" button. 

Click it, select a name for the file and save it. The Adobe PDF document is created on your hard disk at the required location. 

You can then either send this file by e-mail to somebody else, or process it with PDFtoMusic to convert it into the file format you need.

 
`
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With Mac OS 9

To create PDF files from any music software under Mac OS 9, you must install a small program beforehand in the system "Extensions folder",
like Acrobat PDFWriter or PrintToPdf.

Select the Chooser from the Apple menu, and click on the program icon:

Then close the Chooser. (The AppleTalk setting is irrelevant in this case.)

All these programs behave like a new printer for your computer.
When "printing" a document to it, enter a file name, and the printing result is actually saved in PDF format.

A PDF file of your score is then generated which can be opened by PDFtoMusic.

You can then either send this file by e-mail to somebody else, or process it with PDFtoMusic to convert it into the file format you need.

 
`

http://www.jwwalker.com/pages/pdf.html
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With Linux

Generating a PDF file from any program under Linux needs to use a special printer driver that saves the graphic commands into a file instead
of actually printing them on paper.

You can then either send this file by e-mail to somebody else, or process it with PDFtoMusic to convert it into the file format you need.

With KDE, the "kprinter" command (KDEPrint package) includes an option to generate a PDF file:

If this option is not included in your distribution, you'll probably need to use cups-pdf.
To install it under Ubuntu, please refer to this document:
http://ubuntu.wordpress.com/2006/03/23/print-to-pdf-using-cups-pdf/
To install it under another distribution, please read:
http://www.physik.uni-wuerzburg.de/~vrbehr/cups-pdf/download.shtml

http://ubuntu.wordpress.com/2006/03/23/print-to-pdf-using-cups-pdf/
http://www.physik.uni-wuerzburg.de/%7Evrbehr/cups-pdf/download.shtml
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General application menu

The General application menu is called "PDFtoMusic" on the Macintosh, and "?" on the PC.

About...

Display information about PDFtoMusic: its version and the sound database currently used for playing music. You'll also see whether the
program is registered or if you are using a trial version.
For any question about PDFtoMusic, please provide this information to technical support along with your questions about PDFtoMusic.

Documentation

Opens this manual.

Internet

Go to our Website
Connects to the Myriad website

Go to the discussion forum
This forum is a place where you can discuss with other users, and where the authors of the program regularly weight in. It is designed to host
discussion about general topics. For specific issues, it's recommended to send a problem report directly to the authors through the following
menu option.

Send us an e-mail
You'll send a report directly to the authors, in order to ask a technical question. 

WARNING: please be sure to provide a valid e-mail address, otherwise you won't get an answer from us!
When sending an e-mail to the authors through this option, all the necessary information about your hardware and software us automatically
included, so you don't have to repeat them in your message.

It is possible, and even recommended, to attach a file that will illustrate your query.

Search for a score
You will search PDF files on the Internet using Kooplet.

Language

Program language selection. This submenu allows you to select the language of the user interface.
Currently supported languages are English and French.

Note: on Mac OS X, language change is temporary and is kept only during the current session. 
If you want to change language permanently, you can either: change the Finder language through the "International" control panel, or select the
PDFtoMusic icon in the "Applications" subfolder, apply "Command+I", then deactivate the languages you are not interested in. 

Ordering

You are connected to the our online store, from where you can order our products. 

Please consider that the playback quality of PDFtoMusic, as well as the audio file export (WAV, AIFF, MP3) can be drastically improved by
using GOLD 2 sound base.

Input my registration code

This option is active only if your copy of the program is not registered yet. To do it, enter your personal details, as well as the personal license
number that you received after your purchase. This operation has to be done only once.

http://www.myriad-online.com/resources/docs/pdftomusic/english/kooplet.htm
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Unregister the program

This option is active only if your copy of the program is registered. It wipes out the registration information. You have to do this when you sell
your computer, or if you are using a computer other than yours.

Note: this is important, because you are personaly responsible for keeping the information related to your license confidential.
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"File" menu

Open

Opens the window for selecting a PDF file from your hard disk. The file will be loaded and analyzed. Icons show the computation progress. You
can cancel the operation at any point by either closing the document window, or by hitting the Esc key. You are then asked for confirming the
process cancellation.

Open recent file

In this menu, PDFtoMusic shows the 32 last loaded PDF files. The last item in this menu erases this list.

 

Close

Closes the frontmost document. If you applied changes to the document that have not been saved yet, you are asked for a confirmation.

Save

This submenu is active only if changes have been applied to the frontmost document.
Changes you made to the PDF document are saved, either in the PDF file itself, or in a separate file (depending on your settings in "Settings >
Preferences", "Document" section)

Save as

Saves the PDF document under another name, embedding the changes you applied to it.
It enables you, for instance, to save a separate version of the PDF document that includes your amendments, while keeping the original version
unaltered. 
It is the only way to store your amendments into a PDF file when the setting for "Store Corrections to PDF file" is unchecked in General
Document Preferences.
See this chapter for more details.

Properties

Provide various informations about the PDF file : creator, date, embeded fonts, etc. 

Open with editor

http://www.myriad-online.com/resources/docs/pdftomusic/english/document.htm#save
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The frontmost document is exported (in the file format defined in PDFtoMusic preferences) and opened with the related program.

Export

Exports the frontmost document in any of the available file formats.
You can select the page(s) to be exported, as well as the parts.
Please refer to the file format description chapter for more information.

http://www.myriad-online.com/resources/docs/pdftomusic/english/annexes.htm#formats
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"Edit" Menu

Undo

When a change (amendment) has been applied to the document, you can undo this operation. The 6 last operations can be undone.

Select all

Select all objects. Any change applied to a selected object will be applied also to the other selected objects.

Unselect all

Unselect all.

Delete changes

Deletes all the changes (amendments) that have been applied to music symbols and instruments of the document.

Note: changes that could have been applied to the way fonts have to be handled are not altered by this operation.
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"Performance" Menu

Play

Plays the whole score or the currently selected part.

Pause

Stops music performance, that can be restarted at this point later.

Stop

Stops music performance. A new start will play the score from the beginning again.

Volume

Enables to set up the sound overall volume

Tempo

Enables to set up the tempo (performance speed) of the music

Force played measures

You will define the measures to play. This can be single measures like "8,10,11,13,14,6" or group of measures like "2-12" where measure 2 to
12 will be played.
Measure or group of measure currently edited is show on the document.

Virtual Singer

Enables to decide whether you want the lyrics sung by Virtual Singer or played by an instrument.
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"Display" menu

Drawer

This option is active only when the document is longer that one page. 
Activates/deactivates the drawer related to the document. The drawer shows the document pages as thumbnails. You can jump to any page by
selecting its thumbnail in the drawer.
The number of errors found by PDFtoMusic on this page is also displayed over the thumbnail

Note: you can ask for the drawer to be opened automatically when a new document is loaded, by selecting the matching option in the general
preferences, "Document" section.

Scroll mode

When this mode is active, the miscellaneous systems (staff groups) are not displayed on top of each other, like in a real music sheet, by one
besides the other, as a virtual "ribbon".

Recognition results

When this mode is active, PDFtoMusic displays the symbols it recognized over the regular PDF drawing. These miscellaneous symbols are
displayed in color:

        - notes and rests :         dark blue
        - clef, key and time signature: light blue
        etc.

Measures numbers

Display measures numbers. If a measure is never played, the number is displayed in grey. This can occurs when a repeat symbol is incorrectly
written or wrongly analysed. You can fix this by forcing the played measures list in Performance menu.

Actual size

Resets the document display scale to 100%

Double size

Resets the document display scale to 200%

Full width  

Adjusts the document display scale so that its width fits the window.

Full page

Adjusts the document window size so that it occupies as many space as possible on screen.

Zoom in

Increases the document display scale.

Zoom out

http://www.myriad-online.com/resources/docs/pdftomusic/english/document.htm#drawer


19/04/13 16:16PDFtoMusic

Page 15 sur 49http://www.myriad-online.com/resources/docs/pdftomusic/english/printable.htm

Decreases the document display scale.
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"Correction" menu

As any other system based on computer recognition, PDFtoMusic is not infallible, and can make some mistakes, more or less impiortant
depending on the quality of the document. You can interevene on the recognition result and apply amendments. These changes can be saved
so that they are preserved when loading the document again.
PDFtoMusic offers two ways of saving these amendments.

Instrument

For each staff found in the document, PDFtoMusic shows the related instrument. You can change this instrument as well as its volume,
panning position, octave shift and semitone shift.
If the instrument is human voice, you can specify the language that Virtual Singer will use for singing the lyrics.

A check box activates globally the "surround" effect. This effect increases the panning separation of the miscellaneous instruments, for all the
documents.

Staves and systems

PDFtoMusic includes specific algorithms that "follow" staff lines from a system to another. Indeed, in some scores, some staves can be omitted
in systems. This amendment mode enables you to change the way staff lines are connected together.
A description is provided here.

Fonts

A PDF document includes graphic objects (frames, lines, etc) as well as characters extracted from a font. Those characters can be either
letters and digits, or music symbols.

PDFtoMusic has some manual font recognition settings that can help correct mistakes, which are described here.

Allow multi-voices staves

If PDFtoMusic considers that one or several staves in the document are made of several voices and you are sure of the opposite, you can
deactivate this processing mode.

http://www.myriad-online.com/resources/docs/pdftomusic/english/document.htm#save
http://www.myriad-online.com/resources/docs/pdftomusic/english/problems.htm#struct
http://www.myriad-online.com/resources/docs/pdftomusic/english/problems.htm#fonts
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Allow enhanced chords

Two notes horizontally very close to each other can be considered as belonging to the same chord (there are sometimes chords in which the
notes are not perfectly aligned). This option enables you to deactivate this mode.

Allow tuplets

In some scores, a digit appears near the note to indicate the fingering. In some cases, PDFtoMusic interprets this fingering text as tuplets
(triplets, etc). If there are no tuplets in the piece, deactivate this option to prevent PDFtoMusic from searching for tuplets in the score.

If you deactive this option, PDFtoMusic will no longer search for tuplets in the score.

Allow fingering

If PDFtoMusic recognizes tuplets as fingering notation (this generally provides a bar duration error), you can deactivate fingering seeking for
the whole document.

Allow key changes

It can be sometimes difficult to tell accurately whether the accidentals at the start of a bar are a key change, or regular accidentals that has to
be applied to the following notes.
For instance:

If PDFtoMusic finds key changes on a document that doesn't include any, deactivate this processing mode.

Allow shared lyrics

In some vocal pieces (for instance, Barbershop scores), when several performers sing the same lyrics, only one lyric line is written:

When this mode is active, PDFtoMusic will assign the lyric line to both staves.

Allow clefs vertical shift

Is this mode disabled, clefs vertical position will be ignored

Allow bracket to create groups

Normally, staves groups are notated with braces. Is this mode is active,  bracket also create groups.
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Allow chords name

In some cases, the lyrics line can be constituted by chords names, for example when the singer sing "La La La La". Invalid this option to ignore
chords name processing and add the texts to lyric line and not chord line.

Allow rounded lines

Some PDF draw note stems with rounded lines :

When this mode is enabled, these lines will be processed.

Allow thin beams

Some PDF draw beams with thin lines :

When this mode is enabled, these lines will be processed.

Allow automatic break adjustment

Some PDF include several lyric lines related to the staff with incorrect break symbols (repeats, jumps, endings). When this mode is enabled,
PDFtoMusic tries to create breaks symbols in order to match the actual number of repeats.

High resolution

When a document is made of many tiny staves, some inaccuracy errors can occur in the vertical positioning of notes and rests.
Switching to high resolution increases the precision (and the computation time). You can define that all documents will be loaded in high
resolution from the general preferences.
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Menu "Configuration"

This menu enables you to set up the PDFtoMusic behaviour. Don't hesitate to explore the numerous options carefully. These can prove to be
very useful.

Preferences

Opens the general preference window. You can adjust from here the way the PDFtoMusic interface will react. The miscellaneous options are
arranged in sections.
A complete description of each section is provided here.

http://www.myriad-online.com/resources/docs/pdftomusic/english/setup.htm
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The document window
PDFtoMusic displays Adobe PDF files as documents. Several documents can be loaded simultaneously.

General points
Toolbar
Drawer
Saving files

General points

While loading and processing a PDF file, analysis progress is shown through icons. You can cancel the processing at any point by hitting the
"Esc" key or by closing the window.

Once the analysis is complete, the PDF drawing is displayed in a document window.

Toolbar

The toolbar in the upper part of this window enables you to play music, navigate within the score, pause and restart playback and adjust
volume or tempo (playback speed). 

Tip: to quickly start or stop playback, you can use the space bar.

If the document contains several pages, the following icons enable you to switch to the previous or next page. You can also use the vertical
scrollbar to move through the whole document. 

The next icons change the display scale of the document. 

The "info" icon displays information about the document. These details are extracted from the PDF file: title, document author, creation date, as
well as the character fonts embedded in this document.

If the Adobe PDF document include lyrics, the "bird" icon is present. Click this icon to activate the virtual singer before starting playback. This
default setting can be changed in Preferences, "Document" section.

The "export" icon exports the music piece in the current format specified in general preferences, "Export" section. But you can also select
another format from the file selector, by typing in the matching extension. For instance, to export in Wave format, end the filename with ".WAV".
You can cancel the export at any time by hitting the Esc key.

Right-clicking (or Shift + click) on the toolbar changes its appearance.

The "Setup..." option enables to customise the toolbar icon list according to your needs.

Drawer

If your document contains several pages, the last icon opens and closes the drawer. A drawer is a secondary window, linked to the main one,
that shows a general preview of the document. Click a thumbnail to jump directly to the selected page.
If errors have been found, a warning sign is displayed, specifying the number of errors detected on this page.

http://www.myriad-online.com/resources/docs/pdftomusic/english/printable.htm#general
http://www.myriad-online.com/resources/docs/pdftomusic/english/printable.htm#tools
http://www.myriad-online.com/resources/docs/pdftomusic/english/printable.htm#drawer
http://www.myriad-online.com/resources/docs/pdftomusic/english/printable.htm#save
http://www.myriad-online.com/resources/docs/pdftomusic/english/problems.htm
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Saving files

When amendments have been applied to the document, as for instance a change in the instruments, volume, or music symbols recognition,
you can save these changes so that they will be preserved when loading the file again later.
PDFtoMusic lets you choose beween two modes that can be set up from general preferences.

1- Save changes in the Adobe PDF file itself

Data is preserved in the Adobe PDF file. A backup copy of this file is performed. This doesn't affect the way this PDF file is displayed by other
programs.

The advantage to this mode is that, when you send the file to somebody else, your changes are carried along.

2- Save changes in a separate file

The original Adobe PDF file is not modified, and the data are stored in a separate file, created in the "Correction" subfolder of your user file
space.

Please note that, in this mode, you can still generate a PDF file in which your amendments are embedded by using the "File > Save as..." menu
option.
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Preferences

This dialog box enables to set up the PDFtoMusic behaviour. Don't hesitate to explore carefully the numerous options. It can prove to be very
useful.

Starting

Load documents automatically at startup
If ticked, when the application is started, documents that were open during the last session are automatically reloaded. It's possible to cancel
the processing at any time, either by closing the window, or by hitting the Esc key. You'll then be asked for confirming cancellation.

Open file selector ar startup
When ticked, if no document is loaded when the application starts, the file selector will automatically open, so that you can select a file to be
loaded.

Document

Store corrections in PDF file
When ticked, the amendments you could have applied to the PDF file are stored within the file itself. When not ticked, they are saved into a
separate file, located in the "Corrections" folder of your user folder.

Note: see the chapter about the miscellaneous file saving modes.

Make a backup copy of the original PDF file
If changes are stored in the PDF file itself, you can also ask for a backup copy .bak.pdf to be created at the same level as the original PDF file.
It is even recommended.

Open drawer automatically
When ticked, the drawer will be automatically open if the document contains more than one page.

Open full screen
When ticked the document window will extend over the whole screen when loaded.

Activate Virtual Singer automatically 
You can specify whether Virtual Singer is active or not when a document is loaded. You can specify whether Virtual Singer is automatically
activated when a document is loaded. 

Display recognition results
When ticked, the recognition results will be displayed when the document is loaded.

Note: you can activate/deactivate this display through the "Display" menu.

High precision
When ticked, all documents will be loaded in high resolution.

Note: you can activate/deactivate this feature on a per-document basis through the "Correction" menu.
  
Warn when embedded fonts are missing
Some PDF files do not embed the font drawing for the characters they use. PDFtoMusic can warn you when such a case occurs.

Alerts

http://www.myriad-online.com/resources/docs/pdftomusic/english/document.htm#save
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Display processing errors into a text window

When PDFtoMusic detects an error when processing the document, it will display a small icon over the document itself representing each item
you have ticked in the Alerts panel of general preferences.
In parallel, PDFtoMusic can create a list of all errors encountered as text in a special window (pink background). Right-clicking this window
opens a contextual menu for erasing, saving or printing the window content.

The following items enable you to mask some errors (these errors are still present but no longer displayed). Here are the descriptions of the
miscellaneous processing errors

Display "Impossible to apply beam"
PDFtoMusic recognized a character that looks like a beam, but couldn't find any music symbol close enough. 

Display "Impossible to apply ornament"
PDFtoMusic located a character that looks like a note ornament, but couldn't find a note close enough.

Display "Broken slur"
PDFtoMusic recognized the shape of a slur (possibly a tie), but either it could find the source note for this slur but not the target note, or it could
find the target note but not the source. It therefore can't apply the slur.

Display "Impossible to find a measure for this symbol"
PDFtoMusic recognized a musical character in the document, but could not relate it to any measure (bar) area. It can happen for instance for
some time signature indicators that are put as a reminder at the beginning of a line.

Display 'Impossible to find the reference note on tablature"
When the document shows tablatures for fretted instruments, PDFtoMusic estimates the duration of notes written on the tablature by seeking
for the matching note in the regular staff. If PDFtoMusic can't find this reference note, it generates this error.

Display "Incorrect measure duration"
When several staves are present in a single system (staff group), PDFtoMusic checks that the duration of each bar is consistent. If PDFtoMusic
detects a difference in measure duration, this error is generated. It can occur in the following situations:

    . PDFtoMusic made a previous miscalculation either when extracting the symbol duration, or when locating chords within the measure
(especially when notes in chord are not on the same vertical line)

   . There is an error in the source score's notation. This may depend on a number of factors, including the overall accuracy of the source
program used to create the PDF.

In some cases, PDFtoMusic can consider two notes that are horizontally close together to be in chord, instead of considering that they are
consecutive.
By un-checking the various options in the "Correction" menu, you can deactivate the display of specific types of errors that cause "Incorrect
measure duration" warnings.

Export

The export settings don't affect batch processing, which uses its own options.
When loading a PDF file, PDFtoMusic analyzes it automatically. It can then export it immediately in any of the available formats, and open this
resulting document in an external application. The following options are available in the Export tab of the Preferences:

Export all opened files automatically
This check box activates/deactivates the automatic export.
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"to folder..." 
If automatic export is activated, use this option to select the path to the folder where the resulting documents will be stored.

The "Change" button enables you to select another (file) path.

"File format"
This pop-up menu lets you select the export format to be used (Cf appendix about format description)

Open automatically exported files 
When this option is active, each exported document will be opened automatically by the program of your choice (it supposes that the selected
software is capable of reading this kind of file).

The "Edit" button enables you to select the application that will be used for opening each of the export file formats.
The "Delete" button lets you specify that you don't want this format to be processed.

Glyphs

PDFtoMusic uses optical recognition algorithms on music fonts to detemine the meaning of each symbol. 

Store glyphs into a cache
When this option is ticked, symbols that have already been encountered at least once will be processed more quickly.
However, activating this option can lead to a bigger memory consumption.

Erase font cache at exit
When this option is not ticked, glyphs are preserved from one session to another.
Deactivating this option can lead to a bigger memory consumption.

Note: the glyph cache is located in the preference folder: 
"Myriad Preferences/PDFtoMusic/GlyphesData". Please do not apply any action to this folder while PDFtoMusic is running.

http://www.myriad-online.com/resources/docs/pdftomusic/english/annexes.htm#formats
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Kooplet

Introduction

Kooplet is a search engine specialized in music scores.

From a note pattern Kooplet will display a list of documents from the Internet that contain this pattern. 
Processed file formats are those containing all necessary information to provide an editable score. For instance, digital audio formats
(wav,aiff,mp3,etc) are ignored. 
Kooplet will provide links to files in Myr, PDF, Mu3, Mus, XML, MXL, Abc, Etf, Tef, Nwc, Enc, Tab, Mid, Kar, Mod, S3m, Cmf, Sty, Rhp, Etf,
Gp5, Gp4, Gp3 or Gtp format. 
PDF files can be converted by PDFtoMusic or PDFtoMusic Pro, the others can be imported directly in Harmony Assistant.
By clicking the "Play" button below the search result area, you'll be able to hear the note pattern in its context. 

Three search modes are available. Search mode can be selected from the first icon in the toolbar: 

- Search for pitch, regardless of the rhythm

- Search for rhythm, regardless of the pitch

- Search for both pitch and rhythm
 
It is also possible to search music score files for text, as well in the titles or comments as in the lyrics.

If a text and a music pattern are entered, result documents match both the text and the pattern.

Contrarily to other generic search engines, Kooplet extracts information from within the music file content. 
 
Documents are not stored on the Kooplet servers but remain on the site where they have been found. Therefore, when downloading or viewing
a document, you will read it directly from the original site that hosts it. 

The toolbar

The toolbar changes according to the selected search mode, or whether you insert notes or rests, etc.
From left to right, you can find:

- Search mode selection
- Start and stop pattern playback
- Delete the whole pattern
- Pattern input from the microphone (experimental)
- Sharp mode for note input
- Note/Rest input mode
- Symbol duration
- Dot mode

Tips

You can add symbols by clicking the virtual keyboard.
If you click the keyboard or the staff with the Shift key down, you hear the note without inserting any symbol.
If you click a symbol with the Alt key down, it is deleted.
If notes are selected in the frontmost document before Kooplet is activated, these note will be used as search pattern.

Advanced search

When searching for a text, if you write the words between quotes, search will be performed on these words in this order. Without quotes, it will
be performed on these words in any order.
For instance, if a score contains lemon tree, it will match the tree lemon search, but not "tree lemon" between quote marks.
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If you write a minus symbol before a word, this will have to be absent from the document text.
For instance, if you search for Ave Maria -Gounod, matching files will contain the words Ave and Maria, but not the word Gounod. 

The "Setup" button set up the search broadness.
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Amendments

No recognition algorithm can be 100% reliable. In the event you encounter translation errors, PDFtoMusic offers some tools to help you fix
them.

Fonts
Symbols
Staves and systems

Fonts

PDFToMusic extracts character fonts from the PDF document, in order to "read" the music sheet. However, when a PDF document is created,
fonts are not stored as is in the file, but transformed. First, to shrink the file size, only used characters are embedded.The name of the font is
also often encoded. Moreover, no clue is provided that would enable PDFtoMusic to distinguish it without fail.

Some portions of text can be written with a default font (Times, Courier, ...), directly managed by the PDF format. In such cases, the font is not
included in the PDF file and won't appear in the recognized font list. 
 
In a first step, PDFtoMusic tries to extract a consistent font name, and searches for it in its known font name database. If the name is found, the
font is considered as "forced, application". You can't change this status.

If the first step gets nowhere, PDFtoMusic applies dedicated algorithms to distinguish between text and music fonts. Fonts are then marked as
"Text, auto", or "Music, auto". You can change this status through the "Correction > Fonts" menu option and, for instance, change a text font to
music font.  

Tip: double-clicking a character on the PDF document opens this window with the matching font selected.

 
 
 
This change can be limited to the document or applied to all documents. 
 

http://www.myriad-online.com/resources/docs/pdftomusic/english/printable.htm#font
http://www.myriad-online.com/resources/docs/pdftomusic/english/printable.htm#symbols
http://www.myriad-online.com/resources/docs/pdftomusic/english/printable.htm#struct
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If limited to the document, only the current document will be affected by this change.
If applied to all documents, each time the font name will be found again in a PDF file, its state will be forced. Of course, this option has to be
used wisely. You therefore create your own database of the fonts that are the most frequently found.  
 
Please note that these changes can be stored in the PDF document, and kept from one use of this file to another, or if you send the document
to another user. 
In this last case, the font name database of the recipient won't be altered.
 
Once fonts have been marked as music or text, they are processed accordingly by PDFtoMusic. 
 
Music fonts are optically analyzed, character by character, in order to guess the meaning of each of them.
 
For text fonts, the operation is a bit different. PDFtoMusic uses first the Unicode data from the PDF file. In most of the cases, the result is
consistent. However, some PDF files don't provide accurate Unicode data. It's rather easy to realize: recognized text is completely different
from the original one. 

Here is for instance what you see in PDFtoMusic:

And once the result is loaded in a music notation software:

PDFtoMusic offers a solution to this problem by making "Text font, with optical recognition" editable. Once a font is marked as such, if it
appears that there are errors in the default optical recognition (some characters are very close to each other: I and 1, O and 0, etc), you can
remap the associated keystroke for any character. To do so, click on the character preview, and then press the key on your keyboard which
you would like associated with that particular character symbol. From this point, the result of the recognition is changed.

The characters you modify appear in a different color on the preview.
Amendments to the recognition are stored in a database, so that when a strictly identical character is found later in another document, it will be
amended automatically. PDFtoMusic "learns" in order to ease your work.

To input a Unicode character which can't be entered directly from your keyboard, like for instance, Greek or Hebrew, let the command key
(Apple key on MacOS, Ctrl key on Windows) depressed, while entering the Unicode value of the character (in hexadecimal). 
For instance, Command+0394 will define the capital greek delta.
A summary of Unicode values can be found here: http://www.ssec.wisc.edu/~tomw/java/unicode.html
 
Finally, some fonts don't include either music symbols or digits and letters, but graphics. Examples of this would be accordion register
indicators, guitar chord diagrams, embellishments, etc.
In these cases, you can specify that the font has to be processed as graphics.
The miscellaneous characters of this font will then be considered to be graphics, and exported accordingly in the result file. 

http://www.ssec.wisc.edu/%7Etomw/java/unicode.html
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Once imported into Harmony Assistant, it gives:

Symbol correction

When moving the mouse pointer over a music symbol, its color changes: 

 



19/04/13 16:16PDFtoMusic

Page 31 sur 49http://www.myriad-online.com/resources/docs/pdftomusic/english/printable.htm

 
Right-clicking opens the contextual menu related to this object. 

    
 

In this menu, you can change the object settings. This is very useful, for example, when PDFtoMusic interprets a particular object incorrectly. 
The red cross remove the object from the PDFtoMusic processing.
The green cross restore the object initial state. 

To select several objects, apply a right click outside any object and define the area. All objects in this area will be selected.
To add several objects to the existing selection, do the same with Alt key pressed.
To remove several objects to the existing selection, do the same with Command key pressed.

You can select all objects from the Edit menu.

All change applied to a selected object will be applied to all selected objects with the same kind.

Staves and systems

A music score is made of several pages. Each page shows staff lines, joined in systems by a vertical line on the left.
There can be therefore several systems in each page.

When a performer doesn't play anything during several bars, the matching staff is often omitted in the system.
PDFtoMusic applies complex algorithms to "follow" staves from one system to another, and bring the parts together.
You can amend this result through "Correction > Staves and systems".

In this mode, the score is displayed in gray, while systems are shown as a blue vertical bar and numbered: S1, S2, etc.

Between each system, a glue tube enables you to merge systems.
Between each staff, a pair of scissors enables you to split the system.

Click the icon to apply the operation.
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If you need to apply the same operation to the whole page, the whole document, or to the same place on all pages, right-click the icon and
select the operation mode from the contextual menu.

Each part is marked with a letter, possibly followed by its name between brackets.
If you applied a change, the part name is displayed in green.
Clicking the blue arrow in the staff opens the contextual menu for relating the staff to the part:

- Automatic computation:
Cancels an applied change, so that the link between staff and part is computed by PDFtoMusic again.

- Exclude from computation:
The staff will be ignored. It enables you to remove a staff for computation, so that it isn't exported.

- Part list:
Choose in this list the part to which the staff has to be related.

- Create new part:
Creates a new part and relates the staff to it.

If the error you fix has occurred on all pages, right-clicking the staff name opens a contextual menu, enabling to apply the staves arrangement
of the current page to all the other pages of the document.
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The mixer
You can open the mixer from the Windows menu.

The mixer show the play state of the frontmost document.

For each part we found :

1. The singer language (if the part has related lyrics). You can click on the flag to change it.
Right click to change all languages.

2. The current sound level. It can vary according to the general volume, the paning and the dynamics.
3. The volume and the paning. You can change them.
4. The octave shift.
5. An icon to change the related instrument.
6. An icon to mute the part. Right click mute all the other parts.

At window bottom :

1. An icon to reset all values.
2. Surround enabling.
3. General volume.
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Virtual Keyboard
You can open the virtual keyboard from the Windows menu.

When a music is playing keyboard keys are show.

  You can select:

1. The part to display.
2. Number of octaves.
3. Value of first octave.
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What's new ?

Version 1.4.0 / April 2013
This version brings an enhanced stability, a better symbol recognition, new computing options as well as some user interface improvements. In
particular, it's now possible to group objects together and apply changes to all of them at once.
Two new floating tools are included : mixer and virtual keyboard.
The played measure list can now be forced.

News and Improvements

1. New floating window: Mixer
2. New floating window: Virtual Keyboard
3. Quick opening of the current document in the score editor of your choice.
4. Page change on Pg Up & Pg Down keyboard keys
5. Specific processing of thin beams ("Correction" menu)
6. Specific processing of note stems drawn using curves ("Correction" menu)
7. Better management of slurs across end of line
8. Lyrics language displayed through a small flag
9. Improvement of language automatic recognition

10. Improvement in text spacing recognition
11. Optional display of file complete path in the window title
12. New setting for playing the score automatically after processing
13. Independant key signature change on staves
14. Corrections are applied to all selected objects of the same type
15. Now possible to select objects through discontinuous selection, exclusion of a selection area, selection of one or several staves
16. Edit menu: delete changes on selected objects
17. Edit menu: select all, deselect all
18. Improvement of Da Capo management and better export
19. Management of 7-shapes Fasola notation
20. Improvement in shape note recognition
21. Improvement of title, composer and remarks recognition
22. Improvement in speed for module: staff following from one system to the next
23. Improvement in speed for module: music symbols optical recognition
24. Improvement in ottava symbols processing
25. Management of fontless documents like the PDF files generated by iWriteMusic
26. Better processing of information written outside the staff area
27. Virtual Singer voices (SATB) are better determined and set  
28. Better processing of staff group name
29. A new options enables to display measure numbers and to spot measures that are never played (it's generally due to a mistake in

break symbols)
30. Now possible to force the list of measures to play
31. When compressed MusicXML format (.mxl) is used, pictures of the document are now managed in a standard way, and therefore

imported by programs that can process such embedded pictures (PDFtoMusic Pro only)
32. Miscellaneous PDF-specific graphic settings are now calculated: stem line width, staff line width, grace note size, etc. These settings

are exported in MusicXML (PDFtoMusic Pro only)
33. Shape-note notation management module has been completely rewritten
34. Better management of incomplete measures (anacrusis, upbeats) before or after repeat start and end barlines. 
35. Management of staves with different time signatures 
36. Management of implied tuplets through rhythmic pattern recognition
37. Improvement of chord diagrams recognition
38. Improvement of lyrics and note association
39. New algorithm for grace note tracking and processing
40. Better management of double-sharp symbols
41. Recognition of a new ornament : staccatissimo.
42. Improvement of C (Tenor) clef spotting 
43. Improvement of distinction between key signature and note accidentals. 
44. Management of dotted notes with double stem
45. Better processing of stemless notes
46. Better spotting of dotted barlines
47. Management of tempo text mentions made of several words
48. Better management of arpeggio symbols
49. Better recognition of lyrics language
50. In global setup, default corrections that will be applied when a PDF file is loaded can be selected
51. Better management of numbered parts (endings) at the beginning of a line
52. On documents with several lyric lines, when break symbols are missing or wrong, break symbols can be automatically created to match

the number of repeats.
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53. New option in the export to create a separate file by part (PDFtoMusic Pro only)

Fixes and Changes 

1. Relation between file types and opening application
2. Management of TrueType CID type 2 Fonts
3. Fixed crash on corrupted bitmap pictures
4. Fixed crash when a long line of text is considered as the lyrics syllable related to a note
5. Fixed icon positions when settings are reset to default values
6. Chord line management when conflicting with bar numbers
7. Fixed problem when saving instruments
8. Online search for free PDF score files using Kooplet has been improved, and the quantity of indexed files drastically increased.
9. Some combinations of break symbols and numbered parts (endings) could result in an infinite play.

10. Fixed a problem in shared lyrics recognition.

Version 1.3.1 / May 2012
Improvements

1. Better beam handling
2. PDF files are now managed up to version 1.7
3. Better ledger lines management
4. Management of copy/paste protected PDF files 
5. New version auto detect
6. Better broken slurs management
7. Better 8va and 8vb management

Fixes

1. Recent files menu
2. User's toolbar
3. Mensurstrich notation
4. Dynamics vertical position on one line staves

Version 1.3.1d (May 15, 2012 )

Improvements

1. Title, Composer, Remarks are extracted from the PDF and exported

Fixes

1. Better management of repeat start/end recognized as piece start/end

Version 1.3.1c (April 19, 2012 )

Fixes

1. Possible crash when playing a score that contains lyrics written in an unknown language
2. Windows: Fixed problem in the memory management library of the PDFtoMusic non-pro version, that could

prevent processing of long scores

Version 1.3.0 / March 2011
New

1. The Kooplet music search engine is included, to search the Internet for PDF scores
2. Possible to deactivate the chord name search ("Correction" menu)

Improvements

1. Position of the play bar in multi-rest bars

Fixes
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1. Rest display
2. Marcato Staccato ornament display
3. Tuplet rests in MusicXML export
4. Rests that fill a bar in MusicXML export
5. Rests vertical position

Version 1.3.0c (March 17, 2011 )

1. Repeat barlines between clef and time signature weren't processed.
2. Fixed toolbar update problem when setting up the icons to display
3. Fixed crash on some files, Windows version

Version 1.3.0d (March 24, 2011 )

1. Better management of slurs/ties drawn astride a line break
2. Some chords were incorrectly played arpeggiated

Version 1.2.1 / April-May 2010
New

1. Management of forced bar numbers
2. Management of incomplete time signatures
3. PDFtoMusic Pro: Command-line access (without GUI)
4. PDFtoMusic Pro: Batch processing: Messages can be saved in a log file
5. PDFtoMusic Pro: Expert mode: Maximum grace note size setting

Improvements

1. General improvement of musical or alphabetical characters
2. Better management of double barlines
3. Improvement of numbered endings management

Fixes

1. Page number in the drawer
2. Dots localisation problem
3. On some files, accidentals and grace notes recognition
4. MusicXML export: "<" character in lyrics
5. Space character management

Version 1.2.1c and 1.2.1d ( May 4th - 6th 2010 )

1. Improvement of music export (any format)
2. Improvement in the way melismas are performed by Virtual Singer
3. Improvement of the arpeggio symbol management
4. PDFtoMusic Pro: MusicXML export: stem sizes of secondary staves of a group (e.g. piano bass staff) weren't

properly saved
5. Windows: Packed MusicXML (.mxl) didn't work
6. Windows Vista/7: once the program was installed, the system displayed an alert box saying that the install might

not be completed properly
7. Windows Vista/7: The appearance of dialog boxes could not be as expected

Version 1.2 / April 2009
New

1. The toolbar can now be customized
2. A folder of sample PDF files is now provided
3. It is now possible to exclude break symbols (segno, coda...) from the processing

Improvements
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1. Better export of grace notes (appoggiaturas) in MusicXML.
2. Better recognition and export of tremolos.
3. Better management of repeat start and end symbols
4. Better management of drum staves, especially on documents that only include such staves.
5. .myr export now manages metronome
6. Verse number in lyrics are now better managed.
7. Better recognition for half notes
8. Crossed grace notes are now located and exported
9. Better management of whole bar rests

10. All actions available from menus can be activated through an icon, and vice versa

Corrections

1. Fixed performance of some kind of drum staves
2. Fixed a small problem of file compatibility between PDFtoMusic and Melody Player
3. Fixed problem in beam recognition
4. Crash on embedded Adobe Type 1 fonts with composite diacritics.

Version 1.1 / September 8, 2008
New

1. Packed MusicXML format (.mxl) is now managed
2. Correction Menu : item to allow bracket to create groups
3. Correction Menu : item to ignore the clefs vertical offset
4. Management of implied tuplets
5. Now possible to export in MusicXML 2.0 format (global setup)

Improvements

1. Better management of drum staves
2. Opening a PDF file from the desktop doesn't load the last documents
3. Shift + mousewheel changes display scale

Fixes

1. Confusion between tuplets and part start
2. Chord diagrams management
3. Confusion on drum staves
4. Memory crash when deleting a change made to the document

Version 1.0.4 / April 24th, 2007
New

1. A correction can now be applied to a group of symbols.
Right-click to define a selection area. Symbols in this area appear as selected. Right-click on any symbol in this selection area and
select a correction to apply: it will be applied to all the symbols of the same kind in the selection area.

Improvements

1. Better memory management for page graphic cache. Enables to manage bigger PDF files.

Fixes

1. Seeking of the staff related to chord diagrams

Version 1.0.3 / April 3rd, 2007
Improvements

1. Optimization of processing time
2. Better management for chord name written on shifted lines.
3. Better management of grace notes
4. Accented characters made of two parts
5. Recognition of guitar chord diagrams drawn with an emty grid character and a set of dots
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6. Recognition of some key changes
7. Parenthesis around an accidental or a notehead, when drawn with a text font
8. Font OCR database updated.
9. Macintosh: Multi-screen management

Fixes

1. Recognition and export of the Aiken FaSoLa notation
2. Management of Adobe Type 1 fonts
3. Applying a change on a document with a guitar chord diagram
4. Recognition of horizontal beams, when overlapping a staff line
5. Problem when a chord name was "Re"
6. PDFtoMusic Pro: empty pictures are no more exported in MusicXML
7. MacTel: keyboard management

Version 1.0.2 / February 21st, 2007
Improvements

1. Possible to change note duration AND add or subtract a dot.
2. Crossed grace notes management
3. New keyboard shortcuts for display scale, 200% scale
4. Dynamics merging ensure that the result is logical, for instance to avoid merging "mf" and "sfz"
5. New full screen and drawer management
6. Font OCR database updated.
7. PDFtoMusic Pro: New setting for the expert mode: maximum beam thickness.

Fixes

1. Tenuti recognition
2. Ties within slurs
3. Breve rest recognition
4. Tempi display, edit and export
5. Beamed notes with double stems
6. Stem direction in chords
7. Framed text could interfere with part numbers

Version 1.0.1 /  February 8th, 2007
Improvements

1. When defining a new kind of tuplet, it's added to the tuplet value list.
2. .myr files are now packed.
3. "How to create PDF files with Mac OS 9" chapter added to the manual.
4. "How to create PDF files with Linux" chapter added to the manual.
5. Improvement in bar number seeking.
6. Time signature detection has been improved.
7. Improvement of paragraph recognition for free text objects.
8. Font OCR database updated.
9. .myr export: default instruments for the metronome are automatically created.

10. PDFtoMusic Pro: After changing expert mode settings, possible to compute all the open documents again.
11. PDFtoMusic Pro: In batch export, it's now possible to define the amendments to computation settings that will be applied to each and

every processed file.
12. PDFtoMusic Pro: When editing expert settings, when at least one item has been changed from the reference value, the matching topic

name is highlighted in the list, and the offset from the current value to the reference is also displayed.

Fixes

1. Miscellaneous problems in general settings.
2. Problem that could occur when trying to edit or play a non-vector document (scanned page or not a music score)
3. Infinite loop when selecting a user tuplet
4. Exported page selection in other formats than MusicXML
5. Double barlines at end of bar could be not well recognized.
6. File kind detection according to its extension when exporting
7. Chord names and text related to the staff could be not exported in .myr format
8. Output device related to the instrument when exporting in .myr format
9. Alert about bar numbering when applying correction on systems
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10. Windows: files with accented characters in their name are now properly managed.
11. Windows : default value of the selector when selecting a folder.
12. PDFtoMusic Pro: dynamic size when exporting in MusicXML format
13. PDFtoMusic Pro: "slash notation" export in MusicXML format

Version 1.0.0 / February 1st, 2007
Very first public version.
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Limits

Non processed elements

- Text or page rotation
- Circled fingerings or string numbers
- Different time signature at the same time position

Unregistered version

The unregistered version of PDFtoMusic will only play the first page of a document, and can export only one page at a time.

Explanatory text appears on each exported page processed with the demo version.
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Frequently Asked Questions
Here are some frequently asked questions, along with their answers:

PDFtoMusic displays a score but says that the document doesn't include any exploitable music data. Why?
Some PDF files embed only a single picture for the whole score, instead of  a collection of simple graphic objects. This kind of PDF file has
probably been generated from a scanned paper sheet. PDFtoMusic can't extract and process elementary graphical items in such cases, and
reports that such a document cannot be processed.

How to know whether a PDF file can be processed by PDFtoMusic?
The simplest way is to ask PDFtoMusic to load it. It will then tell you.
Otherwise, open it with Acrobat Reader (or equivalent) and do "Select All". If the PDF file contains exploitable data, the selection range will be
fragmented. If the PDF file contains only a scanned picture that can't be processed either the selection range will be empty, or the whole score
will be selected as a single block.
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Appendices

File formats
Your user folder
Keyboard shortcuts
Useful links

File formats

PDFtoMusic manages several file formats. Here is an overview of each of them.

Adobe PDF format

It's a document format designed by Adobe, PDF standing for "Portable Document Format". It eases the exchange and distribution of any
document. It can store any kind of graphical objects, from text to pictures. 
It's the groundwork of PDFtoMusic.

PDFtoMusic reads this kind of document.

MusicXML format

Designed by Recordare, this format is about to become the exchange file format for music scores. Based on XML, a text descriptive format, it is
now managed by an increasing number of music programs.
In order to open PDFtoMusic to as many people as possible, it has been naturally chosen as the groundwork format for the Pro version of
PDFtoMusic.

PDFtoMusic Pro writes this kind of document.

This format is not managed by PDFtoMusic, in its "non Pro" version.

You can use the Myriad Music Plug-in to embed this kind of file in a web page or the Melody Player to view and listen to list of files of this kind.

MusicXML compressed format

It is a packed version of the MusicXML format. In fact, this kind of file can be obtained by packing a MusicXML file with zip, then renaming the
result file from .zip to .mxl
In the same way, the original MusicXML file can be extracted from the .mxl by renaming it to .zip then unpacking it with any utility that supports
this format (for instance, the original unzip program)
.
Because MusicXML is a descriptive text of the score, these files can be quite large. In order to save bandwidth, either when such files are sent
by e-mail or put on a Website, using a .mxl can be useful.

PDFtoMusic Pro writes this kind of document.

This format is not managed by PDFtoMusic, in its "non Pro" version.

You can use the Myriad Music Plug-in to embed this kind of file in a web page or the Melody Player to view and listen to list of files of this kind.

Myr format

It's a Myriad proprietary format, managed by Melody Assistant and Harmony Assistant.
Music-related information is stored as musical objects.

PDFtoMusic writes this kind of document.

You can use the Myriad Music Plug-in to embed this kind of file in a web page or the Melody Player to view and listen to list of files of this kind.

Mid format

http://www.myriad-online.com/resources/docs/pdftomusic/english/printable.htm#formats
http://www.myriad-online.com/resources/docs/pdftomusic/english/printable.htm#usersfolder
http://www.myriad-online.com/resources/docs/pdftomusic/english/printable.htm#shortcuts
http://www.myriad-online.com/resources/docs/pdftomusic/english/annexes.htm#links
http://www.recordare.com/
http://www.myriad-online.com/en/products/mmplugin.htm
http://www.myriad-online.com/en/products/melodyplayer.htm
http://www.myriad-online.com/en/products/mmplugin.htm
http://www.myriad-online.com/en/products/melodyplayer.htm
http://www.myriad-online.com/en/products/melody.htm
http://www.myriad-online.com/en/products/harmony.htm
http://www.myriad-online.com/en/products/mmplugin.htm
http://www.myriad-online.com/en/products/melodyplayer.htm
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This format, based on the MIDI exchange standard between electronic music devices (keyboards, synthesizers, expanders, etc) contains a
description of the notes that constitute the music pieces, as well as basic information about the score. However, details about the piece
graphical appearance, its page layout, note appearance or ornaments are not stored. Albeit very incomplete, and until the use of MusicXML
broadens, it remains the standard exchange format for almost all music programs.

PDFtoMusic writes this kind of document.

You can use the Melody Player to view and listen to list of files of this kind.

Kar format

It's actually a mid format, to which additional commands have been added in order to store lyrics related to a staff. Originally, this format was
designed to store Karaoke scores (hence its name).

PDFtoMusic writes this kind of document.

You can use the Melody Player to view and listen to list of files of this kind.

Wav format

It's a binary audio format. It contains stereo digital audio data. This format is lossless, which means that it can be loaded, changed and saved
as many times as needed, without any loss in quality (contrary to MP3 or OGG, for instance).

Initially designed for PC, it is now managed by almost any sound editor or player, or CD burning software.
When PDFtoMusic generates this kind of file, it uses the digital sound database that has been installed on your computer. A better quality will
be obtained when using the base GOLD.

PDFtoMusic writes this kind of document.

AIFF format

It's a binary audio format. It contains stereo digital audio data. This format is lossless, which means that it can be loaded, changed and saved
as many times as needed, without any loss in quality (contrary to MP3 or OGG, for instance).

Initially designed for Macintosh, it is now managed by almost any sound editor or player, or CD burning software.
When PDFtoMusic generates this kind of file, it uses the digital sound database that has been installed on your computer. A better quality will
be obtained when using the base GOLD.

PDFtoMusic writes this kind of document.

BMP format

It's a binary picture format. Data is not stored as graphical object, but as pixels.
It is managed by almost all the graphic editors.

PDFtoMusic writes this kind of document.

Structure of your user folder

The user folder contains files that have been created by PDFtoMusic. It is highly recommended to perform backup copies of this folder at
regular intervals.

This folder is located in your user document folder, in the "Myriad Documents/PDFtoMusic" subfolder.

The subfolders are:

"Correction" : If you asked for the corrections not to be stored in the PDF document itself, the changes you applied to the documents will be
stored here. There will be one correction file for each edited PDF.

"Export": When the result from an imported PDF file is automatically exported, it is stored by default in this folder. You can change this location
from the general preferences, "Export" section.

"OCRCorrection": When you amend the result of the character optical recognition, databases are created in this subfolder

http://www.myriad-online.com/en/products/melodyplayer.htm
http://www.myriad-online.com/en/products/melodyplayer.htm
http://www.myriad-online.com/en/products/gold.htm
http://www.myriad-online.com/en/products/gold.htm
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Keyboard shortcuts

Beyond keyboard shortcuts for menu options, some keyboard keys trigger actions:

Spacebar: starts and stops music playback
Down arrow: switches to next page
Up arrow: switches to previous page
Esc: cancels processing of the current file

Useful links

Here is a list of Web sites where you can download music PDF files:

http://dirk.meineke.free.fr 
http://icking-music-archive.org 
http://www.cpdl.org 
http:// www.solovoces.com 
http:// www.sheetmusicnotes.com 
http:// www.score-on-line.com 
http:// www.oldmusicproject.com 
http:// www.free-scores.org 
http:// www.eythorsson.com 
http:// www.guitarpixel.com 
http:// www.cs.nott.ac.uk/~ef/music/ 
http:// www.mutopiaproject.org 
http:// www.jazzbank.com 
http:// www.evatoller.pp.se 
http:// www.kantoreiarchiv.de

http://dirk.meineke.free.fr/
http://icking-music-archive.org/
http://www.cpdl.org/
http://www.solovoces.com/
http://www.sheetmusicnotes.com/
http://www.score-on-line.com/
http://www.oldmusicproject.com/
http://www.free-scores.org/
http://www.eythorsson.com/
http://www.guitarpixel.com/
http://www.cs.nott.ac.uk/%7Eef/music/
http://www.mutopiaproject.org/
http://www.jazzbank.com/
http://www.evatoller.pp.se/
http://www.kantoreiarchiv.de/
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Problem report

If you encounter specific issues that you can't solve, of if you need something precise that can't be fulfilled by PDFtoMusic, you can contact us,
we'll do our best to help you.

Before all:

Ensure that you actually own the most recent version of the program (see our website).
If not, download the new version then check whether your problem still occurs.

How to contact us?

Either :

Send an e-mail to this address "pdftomusic@myriad-online.com", describing your hardware and software configuration, as well as the
problem you encounter, as precisely as possible.

You can also send an e-mail directly from the application, through the "Internet" sub-menu. Please don't hesitate to add a file, as short
as possible, that enables us to reproduce the problem

Send a regular post mail to Myriad, 26 rue Michel de Montaigne, F-31200 Toulouse, France. However, if you have access to the
Internet, e-mail is recommended.

`

http://www.myriad-online.com/en
mailto:pdftomusic@myriad-online.com
http://www.myriad-online.com/resources/docs/pdftomusic/english/menus.htm
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Software license
Non-profit distribution ofthe unregistered version of PDFtoMusic is permitted without prior written notice, provided that the software is
not modified in any way, and is distributed in its entirety (this includes the application, data files, and all accompanying documentation).
For-profit distribution of the above software requires a prior written agreement from the authors, by post, fax or e-mail.

Complete or registered version

By purchasing a complete version of PDFtoMusic, the user accepts the present software license.
The complete version of PDFtoMusic is assigned to its owner, becoming personal and confidential as soon as the personal code that
have been sent to the user after their purchase has been entered in the software. Neither the registered copy of the software, nor the
personal registration number can be distributed in any form.

This license is not limited in time, and remains valid for all new versions of the same product.

It is valid for one user only. If you need to share a registered version of PDFtoMusic among several users, please contact us to get a
site license.

The user is fully responsible for the non-distribution of his personal registration number and his registered copy of the software.

Disclaimer

In no event will Myriad, its officers, directors, employees or agents be liable for any special, incidental, or consequential damages
resulting from possession, use, or malfunction of one of their products. 
Neither exchange, nor partial or total refund can be claimed for these products after the user has received and read his personal
registration code. 
Myriad reserves the right to invalidate and to disable at any time the personal registration code of a user following the illegal distribution
of his code or a default in the complete payment of his software license fee. 
In no event will Myriad be liable for any direct or indirect consequence of the invalidation and disabling of a personal
registration code following a default in payment or an illegal distribution of the personal code.

Myriad Software, the Myriad Software logo, MyrScript, Harmony Assistant, Virtual Singer are trademarks of Myriad Software.
Apple and Macintosh are trademarks of Apple, Inc., registered in the U.S. and other countries.
Windows is a trademark of Microsoft, Inc., registered in the U.S. and other countries.
Adobe, Adobe Illustator and Adobe Photoshop are trademarks of Adobe, Inc., registered in the U.S. and other countries.

http://www.myriad-online.com/en/store/order.htm
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Order

The application general menu*, "order" sub-menu, will connect you to our store, from where you can order a PDFtoMusic licence. 

Please consider that the playback quality of PDFtoMusic, as well as the audio file export (WAV, AIFF, MP3) can be drastically improved by
using GOLD 2 sound base.

* Called "?" on Windows, "PDFtoMusic" on Macintosh

http://www.myriad-online.com/en/products/gold.htm
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We wish to thank all people who helped us, since May 2006, by their advices and extensive tests.

MM Aarden, Aguila, Bautista, Belkin, Butin, Faivre, Gershwinou, Good, Groromrom, Herman, Hinchey, Houllemare, De Kloe, Lagarde, LeBow,
Le Calonnec, Legall, Lemaire, Machefert, Nappert, Nicou, Oliveira, Puff, Rouquie.

A special thank to Franck Aguila for having designed and drawn the application graphics.


